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A note about QGIS versions 
This workbook was written for QGIS version 3.10.14, the latest long-term release (LTR). If any 
screenshots in the workbook look different to the ones on your screen it is probably 
because you’re on a different version, or have your toolbars positioned differently, but this 
is unlikely to cause any problems. Most QGIS versions are named after where the 
developers have their meetings (e.g. 3.10 is called A Coruña). The LTR version of QGIS is the 
most stable one, but you will also see a newer version of QGIS on the website – these often 
have more features but are not yet finalised for official long-term release.  
 
This workbook is also available online, at: 
https://automaticknowledge.org/training/workbooks 
 
Licence: Attribution-Non Commercial 2.0 Generic (CC BY-NC 2.0) 
https://creativecommons.org/licenses/by-nc/2.0 
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https://creativecommons.org/licenses/by-nc/2.0
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About Automatic Knowledge 
Our philosophy is all about sharing data 
and knowledge, so that we can all be a bit 
better informed about the world. The way 
we do this is mainly through spatial data 
analysis and visualisation, and as part of 
this we offer training courses in geospatial 
software – mostly QGIS. Alasdair Rae 
(pictured) founded Automatic Knowledge 
in 2019 and also runs the training courses.  
 
Why ‘automatic knowledge’? 
The idea behind Automatic Knowledge is that we do the hard 
work of completing the journey from data to knowledge, so that 
you can then make more informed decisions. These training 
sessions will hopefully help you do that too. 
 
Other activities (e.g. free stuff) 
In addition to training, we provide a range of consultancy 
services, specialising in data, spatial analysis, the built 
environment and cartography. We also publish free and open 
datasets that you may find useful, at: 
 
automaticknowledge.co.uk/resources  
 
We’re also a ‘sustaining member’ of QGIS, which means that we 
donate money to the QGIS project on an annual basis, to help 
fund its development. By taking this course, you’re helping too. 

https://automaticknowledge.co.uk/resources
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Automatic Knowledge training sessions 
The idea behind all our training sessions, and these workbooks, 
is to help you learn new things in an enjoyable way, without 
confusing you. We want everyone who takes one of our courses 
to come away with useful new skills that they can then put into 
practice in their day-to-day work, and build on in the future. 
 
About this workbook 
Following a workbook can be a great way to learn new software 
skills, but there’s also a risk that it turns us into robots, following 
step-by-step instructions in a linear way. During the session 
we’ll talk about maps and do some demos of QGIS tasks – 
among other things. The emojis? I add them in for a bit of colour, 
but they also serve a practical purpose because they can help 
us find key sections of the document quickly. 
 
Formatting 
Most font is size 14. When switching between screen and 
workbook this is easier on the eyes. The following format will be 
used in relation to files/folders, websites, QGIS options/tools, 
click actions and any text I want you to input. I’ve also added a 
‘Notes’ section on each page where you can jot things down. 
 
Files, folders and suchlike: e.g. world_countries.shp 
Websites: e.g. www.automaticknowledge.org/training 
QGIS windows, tools, sections, options: e.g. Coordinate 
Actions - click menu item/ button: e.g. Vector > Research Tools 
Text input: e.g. "geounit" IN ('Japan','New Zealand') 

http://www.automaticknowledge.org/training
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1. What is a ‘high impact’ map? 
In a training session about high impact maps, we should 
probably begin by thinking in a bit more depth about what ‘high 
impact’ might mean, why we would want to make these kinds of 
maps, and why we might not. 
 
As a starting point, let’s all go to the link below and I’ll talk us 
through things (I’m not a huge fan of what they’ve called this 
subreddit, but it is 100% maps, and very interesting too). 
 
https://www.reddit.com/r/MapPorn/ 
 

 Let’s sort by Top and All Time 
 
Starting at the top, we’ve got (as the time of writing): 
 

1. US politics 
2. Chicken nuggets 
3. Arizona voting precincts (and Native American areas) 
4. World War 1 
5. Eagle tracking 
6. A topologist map of the world (showing borders) 
7. Passenger railway networks 
8. Wolf tracking (territories) 
9. ‘When a band announces a world tour’ map 
10.  France’s longest border – shared with Brazil 

 
There are thousands more. They made an ‘impact’. 

Impact? A nice conversation with a friend can have an impact. A chance 
meeting with an old friend can too. An excellent teacher can have an 
impact. But then again, so can an asteroid or a runaway train. We just 
need to think a bit about what we’re trying to achieve and what impact 
we want to have, and with whom. 

https://www.reddit.com/r/MapPorn/
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Now let’s look at some more carefully selected ones, from this 
subreddit, as well as r/dataisbeautiful. 
 

1. The speed of light: 
https://www.reddit.com/r/dataisbeautiful/comments/dbnt
q8/light_speed_fast_but_slow_oc/ 
 

2. World’s 25 largest lakes, side by side: 
https://www.reddit.com/r/MapPorn/comments/hxl68b/wor
lds_25_largest_lakes_side_by_side/ 
 

3. 90 minute public transit commuter zone – SF vs London: 
https://www.reddit.com/r/MapPorn/comments/f0o8yu/90
_minute_public_transit_commuter_zone_for_london/ 
 

4. US (contiguous) population density map: 
https://www.reddit.com/r/MapPorn/comments/gbr7qy/us
_contiguous_population_density_map/ 
 

5. Coterminous US elevation – 3D scene: 
https://www.reddit.com/r/dataisbeautiful/comments/imrp
ce/conterminous_us_elevation_generalized_by_500km%
C2%B2/ 
 

 They generally look quite nice. 
 Tell us something we already knew. 
 Tell us something we sort of knew. 
 Tell us something we did know. 

https://www.reddit.com/r/dataisbeautiful/comments/dbntq8/light_speed_fast_but_slow_oc/
https://www.reddit.com/r/dataisbeautiful/comments/dbntq8/light_speed_fast_but_slow_oc/
https://www.reddit.com/r/MapPorn/comments/hxl68b/worlds_25_largest_lakes_side_by_side/
https://www.reddit.com/r/MapPorn/comments/hxl68b/worlds_25_largest_lakes_side_by_side/
https://www.reddit.com/r/MapPorn/comments/f0o8yu/90_minute_public_transit_commuter_zone_for_london/
https://www.reddit.com/r/MapPorn/comments/f0o8yu/90_minute_public_transit_commuter_zone_for_london/
https://www.reddit.com/r/MapPorn/comments/gbr7qy/us_contiguous_population_density_map/
https://www.reddit.com/r/MapPorn/comments/gbr7qy/us_contiguous_population_density_map/
https://www.reddit.com/r/dataisbeautiful/comments/imrpce/conterminous_us_elevation_generalized_by_500km%C2%B2/
https://www.reddit.com/r/dataisbeautiful/comments/imrpce/conterminous_us_elevation_generalized_by_500km%C2%B2/
https://www.reddit.com/r/dataisbeautiful/comments/imrpce/conterminous_us_elevation_generalized_by_500km%C2%B2/
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We can also think about impact more generally from a visual 
perspective, beyond maps. 
 
Take this example from the UK, where I looked at voting and 
deprivation patterns. 
 
https://twitter.com/undertheraedar/status/120542910852148019
2?s=20 
 

 
Again, the results aren’t very surprising – but perhaps they are a 
bit surprising. Let’s have a think about what’s encoded here: e.g. 
colour, order, geography. 

Remind me to tell you the back story to how this went from very quick 
and dirty Excel effort to different versions being in The Economist and 
on Sky News. I think the process and steps are quite important 
because a lot of this is serendipitous (e.g. my global density spike map). 

https://twitter.com/undertheraedar/status/1205429108521480192?s=20
https://twitter.com/undertheraedar/status/1205429108521480192?s=20
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Some thoughts on ‘high impact’ maps. 
 

 They affect our emotions (so: politics, nature, identity etc). 
 They don’t have to be pretty, at all. 
 But they might be pretty, often are. 
 Often quite simple (conceptually and visually). 
 Easy to understand. 
 Easily shared – Twitter, Facebook, Instagram, Reddit, etc. 

 
‘Quick scanners’ – this is most people and contexts now, 
probably. Something to keep in mind when making maps. 
 

 
 
https://twitter.com/sannehombroek/status/13613835998666014
73?s=20 

https://twitter.com/sannehombroek/status/1361383599866601473?s=20
https://twitter.com/sannehombroek/status/1361383599866601473?s=20
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Task: think of a map that made an impact on you, good 
or bad, at any time – and let’s take a look at some of 
them – please share some links or even just a 
description so that we can all look at them. 
 
Characteristics of ‘high impact’ maps (we don’t want all maps 
to be ‘high impact’ of course - that would be too much). 
 
Jot down some thoughts below and we can compare notes – I’ll do it too. 
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2. ‘Principles for the orderly loss of information’ 
We’re going to do some mapping in QGIS soon, but first I want to 
introduce my ‘principles for the orderly loss of information’ – a 
set of ideas I put together in an academic paper more than a 
decade ago which I often go back to when making maps.  
 
Here they are, translated from academic English to 
something approaching normal English (really!).  
 

 ‘expansive inclusion’ (include all possible data elements 
at the outset) – i.e. don’t filter out anything to begin with. 

 
 ‘iterative loss’ (filter the data iteratively to derive 

meaning) – i.e. get rid of any junk in a series of steps. 
 

 ‘simplicity from complexity’ (aim to identify key patterns) 
– i.e. what is the message or story of the data and how can 
we find it? (filters and blend modes can be useful here) 

 
 ‘optimal compromise’ (recognise that a series of 

analytical compromises are necessary in spatial data 
analyses) – i.e. recognising that any final result, however 
pretty or fancy, leaves things out and is some kind of 
compromise. 
 

These principles are included in a number of papers, mostly 
hidden behind paywalls, but here’s an open access one: 
https://link.springer.com/article/10.1007/s12061-016-9196-0. 

https://link.springer.com/article/10.1007/s12061-016-9196-0
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Some of these ideas are based on the notion that we can move 
from data (unstructured elements) to knowledge (information, 
imbued with meaning) but of course things do not necessarily 
work in a linear fashion like this and there are all sorts of other 
complications we need to consider – including context, who our 
intended audience is, who the actual audience ends up being, 
and many more. 
 
Nonetheless, I have found that these Principles for the orderly 
loss of information are quite useful in the preparation of maps 
and graphics that make an impact on people. 
 
I’d like us to look at a short Twitter thread now that incorporates 
some of these principles. 
 
https://twitter.com/undertheraedar/status/134295110806347366
4?s=20 
 
The second one in particular serves as a good example. 

 
 
 
Some of the examples are a bit wild, but I included them all as 
they demonstrate different approaches to the same thing – 
how to filter out junk to get to the meaning/insights. 

https://twitter.com/undertheraedar/status/1342951108063473664?s=20
https://twitter.com/undertheraedar/status/1342951108063473664?s=20
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3. Let’s look at an example in a QGIS Atlas 
Enough talking and listening for now – let’s get going with some 
QGIS. 
 

 Open QGIS now and then while it’s loading up you can get 
the data (see below). 

 
 We’re going to open up a QGIS Atlas – since this course is 

for people with QGIS experience, ideally you will already be 
familiar with how the Atlas works, but if not don’t worry – 
we’ll work though it step by step.  
 

 Go to http://automaticknowledge.org/training/data/ and 
download the files from atlas_1… to atlas_5… and then from 
the /styles folder within the /data folder, download the five 
corresponding atlas qml files, plus the QGIS project file I’ve 
put there – qgis_next_level_ATLAS_layout.qgz. 
 

 Once you’ve done this, you just need to open up the QGIS 
project file and then you’ll probably get the Handle 
Unavailable Layers warning so you need to click each file, 
then Browse to tell QGIS where they are stored. 
 

I’ll help anyone who needs it but hopefully everyone has the 
data and the QGIS project activated now. You’ll recognise it if 
you’ve done our Taking QGIS to the Next Level training session. 
It’s an Atlas of countries, with some population and economic 
data for each. It will take a few minutes to set up – no rush. 

http://automaticknowledge.org/training/data/
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Follow along demo time 
Now that we all have the Atlas up and running, follow along with me. 
 

 Let’s open up the Print Layout and then turn the Atlas on  and then 
we can maximise the window and make sure the page takes up the full 
print layout area too . 

 
 You should see the names of the countries at the top of your Print 

Layout screen, starting with Afghanistan. 
 
 Now I want you to take a few minutes to explore different countries – 

using the dropdown button beside the country name at the top of the 

Print Layout - . 
 
 Look at the different elements in the Print Layout – the flag, the map, the 

labels, the title, the numbers and how they are formatted, the inset map, 
the colours, the text in the top right, the little black lines at the top and 
bottom of the page. 

 
 Now look at Colombia – this is a good example that shows off what I’ve 

tried to do with regard to labelling. We’ll think more about labels later. 
 

 
I’ll now explain a bit more about my different choices here and 
also look more closely at the different elements and what my 
thinking was.  
 
Feel free to ask questions and make suggestions here – I am 
sure you can think of ways to improve what I have started. 
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Time to save your work 
You haven’t done much editing to this project. 
 
Nonetheless, you have told QGIS where to find the individual layers for the 
project and you should also have turned off the title message via View > 
Decorations so it’s wise to save the project anyway – it hardly takes up any 
disk space and then you can open it up later if you want to play with it. 
 
I recommend saving regularly (I’ll add the disk icon to remind you) and 
also saving incrementally. So, this time save your project as something like 
qgis_high_impact_maps_p13 and from then on just save it with a different 
page number appended.  
 
This way, if disaster strikes, you can always go back to a specific point and 
pick it up from there again. 
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4. Let’s recreate a best practice example 
I always like to learn from others, and when it comes to map 
and data stuff there are so many good examples to choose 
from – whether it’s colours, layout, fonts, titles or whatever. 
 
Before we have a go at recreating something that I consider to 
be a nice, clean example of ‘best practice’, here are some good 
places to look for inspiration – below. 
 
 See maps and graphics produced by the teams at the 

following organisations. In general, you can just put the 
names of these organisations into Google, Twitter etc. and 
just add ‘maps’ or ‘graphics’ or ‘dataviz’ and you’ll see some 
good examples. 
 

o The Financial Times (UK) 
o The New York Times (US) 
o The Economist (UK) 
o National Geographic (US) 
o Berliner Morgenpost (Germany) 
o Bloomberg (US) 
o South China Morning Post (Hong Kong) 

 
 There are many more examples from news organisations, 

and many, many talented individuals and teams – these are 
just a few.  

 
 Also see www.informationisbeautifulawards.com 
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I don’t generally like to single out individuals but if you’re looking 
for some further inspiration then I recommend the following. 
 

1. Joshua Stevens: www.joshuastevens.net/portfolio 
 

2. Hannah Dormido: hannahdormido.com/work  
 

3. Bill Rankin: www.radicalcartography.net/index.html 
 

They are all great, and Bill Rankin in particular is very original in 
his outlook, plus I like the idea of radical cartography. 
 
Now we’re going to re-create a ‘best practice’ example from the 
2017 UK General Election, based on an election map produced 
by the Financial Times (aka the FT). See below for the original. 
 
The FT election map, 2017 (scroll down the linked page a little):  
https://enterprise.ft.com/en-gb/best-of-ft/ 
 

 Now take a look at the version of the same map that I 
created in QGIS: it’s in the data/images folder for today’s 
session - UK_GE_2017_results_FT_style.png. 

 
 Have a close look at it and you’ll see that it’s very similar, 

but I’ve also made some changes – mostly superficial. 
 

 Now I want you to go to the website below and download 
the …v7.gpkg file (it’s a UK general election dataset):  

http://www.joshuastevens.net/portfolio
http://www.radicalcartography.net/index.html
https://enterprise.ft.com/en-gb/best-of-ft/
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github.com/alasdairrae/wpc/tree/master/files 
 

 I put it together from multiple sources in the run up to the 
2019 General Election and it was used quite widely at the 
time (see github.com/alasdairrae/wpc for more info). 

 
 Open a new QGIS project now.  

 
 Now I want you to add the 

uk_wpc_2019_with_data_from_v7.gpkg file to QGIS, style 
it, and then work towards re-creating the FT map in a new 
Print Layout – either modelled on my version or theirs. 
 

If you’re not sure how you’d go about this, that’s fine – I will do a 
walk through as well – in this case we can just take our time 
and I can talk through things as needed.  
 
This is a good example of where the 
QGIS colour picker comes in really 
handy, since you can just pick the 
colours directly from your screen – no 
messing about typing in RGB colour values or html codes. 
 
If you’re not sure of the best approach to adding the little inset 
maps here, don’t worry – we can go through these elements as 
well. Oh, and one final tip: to avoid annoying people from Orkney 
and Shetland, don’t call them ‘the Shetlands’ or ‘the Orkneys’! 

https://github.com/alasdairrae/wpc/tree/master/files
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The idea now is that we can spend some time getting our Print 
Layout into good shape, taking care about text placement, fonts, 
insets, frame widths, legends and so on. 
 
Once we’ve done all this, we should have 
something that looks like the original 
version, or my slightly modified version. 
 
To the right you will see one minor map 
innovation I have tended to use in recent 
years. I prefer to use insets like the ones on 
here as I believe it is useful. But for anyone 
not from the UK, or not familiar with its 
geography, it’s impossible to say where 
Orkney and Shetland are located in reality. 
That’s why I’ve included a little graphic below the inset maps 
that shows the location of the places shown in the insets. I could 
have called this something like ‘Location of inset maps’ but I’ve 
left it blank for now as I think it’s fairly intuitive (maybe I’m wrong 
– I’m kind of 50/50 on this one). 
 
Before finishing, have a think about elements that you could add 
to a map like this – e.g. add in the number of areas for each 
colour in the legend, add thin border lines – i.e. helpful extra 
information that doesn’t over-burden the reader. 
 

 Export your Print Layout as a 300dpi png and Save your 
QGIS project again now. 
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5. Let’s look at blend modes in QGIS  
Okay, let’s move on from the fundamentals above and work on 
some data that will allow us to make a much fancier map – 
perhaps even one that will elicit a few ‘oohs’ and ‘aaahhs’. 
 
Talking of ‘oohs’ and ‘aaahhs’, one of the best ways to generate 
these is through shiny global connection maps – e.g. remember 
the blue-on-dark Facebook connections map from 2010? 
 
It was produced by Paul Butler in 2010 when he was a Facebook 
intern, and it is very cool. See below for the link. 
 
https://paulbutler.org/2010/visualizing-facebook-friends  
 
His write-up of the 
process is worth a 
read in your own 
time but we’re going 
to do something 
similar in terms of 
global connections 
and glowing lines, 
with a dataset I 
prepared for you.   
 
 
Once we’ve got the data on screen we’ll use blend modes. See 
the next page for what you need to do. 

https://paulbutler.org/2010/visualizing-facebook-friends
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The global flights dataset 
Using open data from http://openflights.org I created a 
csv file of flight connections so that they could be 
mapped. I then joined airport information to this, so that 
for each route I could identify the origin and destination 
city and country (we can use this to filter later on). You 
could do all this yourself using nothing more than a 
VLOOKUP in Excel, with the routes.dat and airports.dat text files 
available from OpenFlights: 
 
https://openflights.org/data.html (this link is just for info) 
 
In order for QGIS to be able to draw lines between points, all I 
had to do was create a new column (which I did using 
concatenate in Excel), with individual entries for each airline 
route, in the following format: 
 
linestring (39.9566 43.449902, 49.2787 55.6062) 
 
The ‘linestring’ part tells QGIS to draw a line between points. The 
numbers between the brackets are the x and y coordinates of 
the origin and destination airports, with a comma between each 
pair of coordinates, and each x and y coordinate pair separated 
by a space. It’s very simple (once you know how!). 
 
Once QGIS plotted the lines (about 67,000 in a few seconds) I 
saved it as a GeoPackage. I’ve put the files in the folder below – 
download all gpkg files, then read on while they download. 

http://openflights.org/
https://openflights.org/data.html
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https://automaticknowledge.org/training/data/flights 
 
If you have slow or misbehaving internet, feel free to just 
download the airline_flows_all.gpkg file – that will be fine – but 
get them all if you can. I also put the original csv file in the same 
directory, for reference (it can be imported via Delimited Text). 
 
Now we’re going to do another follow along, to get us 
started, but after that I’ll leave you to it so that you 
can experiment further, with my suggestions.  
 
 

 Open a new QGIS project if you haven’t already – and be 
sure to have saved the one you were working on 
previously.  

 
 Add the airline_flows_all_with_dist.gpkg file to QGIS now – 

I find it easiest just to drag and drop it right into QGIS. If you 
weren’t able to download this file (the largest one) then 
you can just use the smaller one. 
 

 When you add it to QGIS it 
will look vaguely world-
shaped, but it won’t look 
very nice or interesting – 
just a bit like the mess of 
lines you see here.  

https://automaticknowledge.org/training/data/flights
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 First of all I’m going to change the project background 
colour to #111111 via Project > Properties > General and then 
Background color. This is very dark, but not quite black. 
 

 Then let’s change the line colour to #0032ff, width, Opacity 
to 15% and 0.1 Stroke width. 
 

 Okay, looks better now, but not quite right – so now we’re 
going to use the Blending mode options in QGIS, which we 
access via Layer Properties > Symbology and then Layer 
Rendering at the bottom of that (read the bit below now). 
 

With the Blending mode options, we need to understand what 
does what. There are two ways to apply a Blending mode, as 
follows (you can also blend objects in a Print Layout). 
 

 Layer – this option blends one layer (like our airline flows 
layer) with other map layers above or below it – or the 
background. 

 Feature – this option blends features within the same layer 
– e.g. our individual flight route flow lines. In our case we 
have thousands of overlaps so this can be a useful feature.  

 

Hmm, okay, but what exactly do all these different 
Blending mode options actually do? Well, a great way to 
find out is to try different ones, so here are the definitions from 
the QGIS documentation – try each one in QGIS as you read. 
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Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to 
blend with the pixel beneath it. The colors aren’t mixed. 
 

Lighten: This selects the maximum of each component from the foreground and 
background pixels. Be aware that the results tend to be jagged and harsh. 
 

Screen: Light pixels from the source are painted over the destination, while dark pixels are 
not. This mode is most useful for mixing the texture of one item with another item (such as 
using a hillshade to texture another layer). 
 

Dodge: Brighten and saturate underlying pixels based on the lightness of the top pixel. 
Brighter top pixels cause the saturation and brightness of the underlying pixels to 
increase. This works best if the top pixels aren’t too bright. Otherwise the effect is too 
extreme. 
 

Addition: Adds pixel values of one item to the other. In case of values above the maximum 
value (in the case of RGB), white is displayed. This mode is suitable for highlighting 
features. 
 

Darken: Retains the lowest values of each component of the foreground and background 
pixels. Like lighten, the results tend to be jagged and harsh. 
 

Multiply: Pixel values of the top item are multiplied with the corresponding values for the 
bottom item. The results are darker. 
 

Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used 
to tweak and colorize underlying layers. 
 

Overlay: Combines multiply and screen blending modes. Light parts become lighter and 
dark parts become darker. 
 

Soft light: Very similar to overlay, but instead of using multiply/screen it uses color 
burn/dodge. This is supposed to emulate shining a soft light onto an image. 
 

Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate 
projecting a very intense light onto an image. 
 

Difference: Subtracts the top pixel from the bottom pixel, or the other way around, in order 
always to get a positive value. Blending with black produces no change, as the difference 
with all colors is zero. 
 

Subtract: Subtracts pixel values of one item from the other. In the case of negative values, 
black is displayed. 
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 Okay, just make sure you’ve had a chance to try each of 
the Blending mode options on your flight routes layer and 
take a note of which one you think looks most useful. I think 
Screen works well with this layer. 

 
 Now I want you to experiment with the opacity for the 

flights layer – which we turned down to 15% before – and 
see what impact this has – e.g. with Screen, Dodge or 
Addition. Computer running slow? Let me know. 
 

Task 
For the rest of this part of the training, I want you to 
see if you can create a nice flights viz. You could 
add the airports layer and perhaps filter it so you 
just show a couple of major world airports. 
 
Paul Butler’s big interactive version, for close up inspection and 
inspiration: http://fbmap.bitaesthetics.com 
 
You could add in the Globe Builder plugin and then wrap your 
flight routes round the globe, looking at it from a particular 
perspective. You could also filter the flight routes by origin, by 
destination (e.g. JFK, PEK, LHR, AMS), or by plane type. Just look at 
the fields in the Attribute Table to see what’s possible. 
 
Once you’re happy, export some maps. I put some examples in 
the data/images folder and feel free to share yours with me. If 
you need any help with this task, just ask!  
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6. From little things to big impacts: lines, legends, labelling… 
Seriously? Are we really going to talk about lines, legends and 
labelling? Yes, of course. For some people, these things are 
piffling matters, irrelevant details that only matter to nerds. But, 
add up all the little things – and get them right – and your final 
result can be SO much better. 
 
As a training exercise, we’re all going to make a BAD 
MAP in QGIS. Then in section 9 we’ll take a BAD MAP, 
and make it better (to paraphrase the Beatles). 
 

 Open up a new project in QGIS, making sure you’ve saved 
the previous one (and remember to keep using the 
qgis_high_impact_maps_p23 project name system of 
incremental saving – it’s particularly important here as 
we’ll come back to this project again later). 

 
 Add in the UK General Election results layer from before 

(uk_wpc_2019_with_data_from_v7.gpkg) and then, using 
the guidance on the next page, make what you consider to 
be a ‘bad’ map out of it, making sure to look at each 
different element. You can use any of the fields in the 
Attribute Table to make your map – it doesn’t have to be a 
colour-by-winning party map. You can see an example of 
the BAD MAP I produced in the data/images folder. 
 

 When you do export your map, be sure to use a suboptimal 
file format as well (e.g. jpg). 
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Map projection – since this is a map of the UK, we could use 
British National Grid as the projection but that would be too 
sensible, so try another one instead – perhaps World Robinson. 
 
Generalisation – we could simplify the lines here to make it 
smoother, but that might break things so let’s leave this one. But 
it’s something to think about. Too generalised and it looks 
clunky. Too detailed and it can be a bit distracting. 
 
Line width – the default in QGIS is 0.26 and I often find this too 
thick. Experiment here. Make your lines either too thin or too 
thick. I normally opt for 0.1 to 0.15, so try 0.4 or above! 
 
Labelling – I chose to label a fairly random selection of places, 
using the 5_GB_places.gpkg layer so you should too! Add in 
weird effects, sizes and wild fonts for full effect. 
 
Legend – make your legend look as technical and unfriendly as 
possible and maybe even call it ‘Legend’ or something similarly 
obvious. Keep all the junk. 
 
Class breaks – if you’re mapping something like % voting for a 
particular party, use weird class breaks instead of the default, so 
that the number in each class varies wildly. 
 
Scale bar, north arrow, title, text – add in these elements as 
you wish, making sure not to do it well. 
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I’m not keen on internet map shaming, so I don’t think you’ll ever 
see me complaining about other people’s maps online – I’ve 
done enough bad ones myself and I’m always learning. 
 
However, I do think it’s useful to keep a memory bank of both 
‘good’ and ‘bad’ mapping practices and examples that we can 
draw upon and learn from (and unusual ones - see below). 
 
Before we talk a bit more about labelling, in the next section I’m 
going to say a little bit about what I think of as ‘productivity 
enhancements’ in QGIS: ways of efficient working that I use 
when I’m creating maps and visuals. 
 

 
Source: https://xkcd.com/2394/  

https://xkcd.com/2394/
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7. Productivity enhancements 
In order to demonstrate some things that I consider to be useful 
productivity enhancements, we’re going to look at the following 
scenario, based on the two layers below, the first of which is 
available in the data folder. The second one is the UK general 
election dataset we’ve been working with already. 
 

 atlas_2_world_cities_natranks.gpkg 
 uk_wpc_2019_with_data_from_v7.gpkg 

 
Scenario: we want to produce a map showing which 
party came second in each constituency at the 2017 
General Election. We want to colour the map so that 
the four largest parties are shown using their party colours, and 
all others as a light grey. We then want to add a thick black 
border round those constituencies where less than 2% swing 
would be required for the seat to change hands. We want to 
add some place labels, to provide a bit of context, and then put 
together a simple Print Layout and then export the map as a 
300dpi png file. But we don’t have long to do it, so we must work 
efficiently. 
 
See below for the steps I’d follow and see if you can repeat 
them. I won’t mention every tiny detail here, just the main bits. 
 

1. Add the two layers to QGIS (uk_wpc… first), making sure the 
points layer is on top of the constituencies layer. 
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2. Filter the places layer using "country" = 'United Kingdom' so 
that only places in the UK are showing. 
 

3. Using a Categorized style in the constituencies layer, use 
second17 as the Value and then hit Classify to see it on the 
map, then OK. We’ll fix the colours soon. 
 

4. Go back to the places layer and Filter it a bit more – I’ve 
used the following filter text but feel free to edit it to 
include/exclude other places as you wish: "country" = 
'United Kingdom' AND "city" IN 
('Leeds','Oxford','Cambridge','London','Edinburgh','Inverness','
Caerdydd','Plymouth','Norwich','Manchester','Belfast','Brighto
n','Birmingham','Glasgow','Aberdeen','Newcastle'). 
 

5. By now you should have a map coloured by who came 
second (with the wrong colours so far) and a few major 
towns and cities showing (though no labels yet). 

 
Top tip 
Use QGIS as a colour picker, just to grab colour values from websites. 
How? 1. Double click a layer to open Layer Properties, then go to Symbology 
if you’re not on it already. 2. Then click the little black drop-down at the end 

of the colour patch you see . 3. Then you just select Pick color and the 
little eye dropper icon will appear and the colour you click on will be in the 
main colour patch now. 4. Click the big colour patch and you’ll see the 
Select Color window with the html and RGB colour values – for polygon 
layers, you’ll have to click the colour patch and then click the next one to 
get to the Select Color window. 
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6. There are a couple of ways I could colour the areas by 
party, but instead of using Categorized I’m actually going 
to use an expression. So I’ll go back to my Symbol Settings 
and then instead of using a set Fill color I’ll put an 
expression in the Expression String Builder box (as shown 
below), using the html colour values I picked from the party 
websites (although I made the SNP one a bit brighter) – 
note that you can just type actual colour names between 
single quotes – e.g. ‘red’. I also changed the outline to white 
and 0.1 width at this time. Once done, press OK until you see 
your map again and all options windows are closed. 

 

 
(translation: ‘in cases when the value from our second17 column is ‘Con’ then use 
the blue colour associated with this html colour code’, and so on…) 

Follow 1 Configure 
Symbol… - 2 Simple 
fill – 3 Edit… to get to 
the Expression String 
Builder. Then you 
can style using an 
expression. 

1 

2 

3 N.B. After you select 
Simple fill, you click on 

the little  symbol – 
it will change to what 
you see here after you 
enter an expression. 
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7. We’re going to do something similar with an Expression for 
the cities layer, using city as the label Value. We’ll make 
London size 14, Birmingham, Manchester and Glasgow size 
12 and everywhere else size 10 (controversial!!!). Then we 
can use modified versions of the same expression (shown 
below, for text size) to set the point size for each place. 

 
CASE 

 

WHEN "city" = 'London' THEN 14 

 

WHEN "city" IN ('Birmingham','Manchester', 

'Glasgow') THEN 12 

 

ELSE 10 

 

END 

 
8. After this, we’ll change the font to Arial Bold, the label 

placement to Cartographic and add a drop shadow and 
white buffer (with 75% opacity) to the labels. 

 
9. Then I’ll quickly create a Print Layout, using an A4 page size 

(Portrait) and add text and a legend using manually drawn 
shapes – although you could use the Legend tool instead. 
 

10. Then I’ll duplicate the constituencies layer, put it second 
from top, Deactivate my expression and use a black 0.3 
outline and no fill, and then Filter the layer using 
"REQSWING" <= 2 to show the most marginal constituencies.  
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11. I can then add a text note to the Print Layout saying 
something like ‘Marginals: constituencies with black 
outlines require a 2% vote swing, or less, to change hands’. 

 
Baffled? 
Don’t worry if you feel in a bit of a spin – I can help unspin it. 
 
If you need some guidance with the steps above, or you just want to walk 
through them with me again, that’s no problem at all. The basic idea is that 
we have used expressions to set colours and sizes, rather than a point-
and-click method.  
 
I’m more than happy to demo anything again. 

 
Other useful tips 
 

 Use View > Preview Mode to see what your map looks like in 
greyscale, or to people with colour blindness. 

 Drag and drop colours directly between colour patches in 
QGIS – e.g. from the Fill color patch to the Stroke color one. 
You can also copy and paste colours. Never done it? Try it. 

 Save a style as Default for a layer – done from Layer 
Properties > Symbology and then Style at the bottom. You 
can also use Save Style… if you want to share your styles 
with others (as qml files). 

 In the Expression String Builder, the middle box has Recent 
(generic) at the bottom, where you’ll find all your recent 
expressions, which you can then use and/or edit. 
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8. Labelling! 
Let’s start this section by looking at the map below. This map is 
only labels, plotted in the location of the polygons they 
represent. It was an experimental map I made of the % of people 
in each small 1981 Census Enumeration District who spoke 
Gaelic. Is it even a map? 

 
Source: 1981 Census 

% of people in each 
1981 Scottish 
Enumeration District 
who were Gaelic 
speakers. 
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The original version of the Gaelic map above was in colour on a 
dark background, with reds for the highest values. The idea here 
was that individual numbers and their spatial distribution were 
particularly important – more so than aesthetics, so I just 
plotted those (I just turned the symbology off on the layer). 
 
Anyway, remember those ‘Principles for the orderly loss of 
information’ from earlier on? Well here they are again and you 
can see how they might relate to labelling. 
 

 ‘expansive inclusion’ (include all data elements at the 
outset) – i.e. give yourself choice: don’t filter out anything to 
begin with (as in our GB or world cities label layers). 

 
 ‘iterative loss’ (filter the data iteratively to derive 

meaning) – i.e. get rid of any map junk in a series of steps 
(i.e. when we filter to only include some places). 

 
 ‘simplicity from complexity’ (aim to identify key patterns) 

– i.e. what is the message or story of the data and how can 
we find it? (e.g. when we highlight megacities only). 

 
 ‘optimal compromise’ (recognise that a series of 

analytical compromises are necessary in spatial data 
analyses) – i.e. recognising that any final result, however 
pretty for fancy, leaves things out and is some kind of 
compromise (e.g. when we label ‘Manchester’, but not 
‘Leeds’ and everyone from Leeds hates us!). 
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Task: let’s take a little time now to look more closely at 
labelling in QGIS, using some data I prepared earlier. 
You can either look at the global level or the UK level. 

 
 Option 1: download 10_world_cities_natranks.gpkg, and 

then apply the 3_world_cities_megacity_2030.qml style 
file to it. Once you’ve done this, explore what I’ve done with 
the different labelling options – including the Manhattan 
lines and what I’ve done to the labels for Mexico City, Delhi 
and Tokyo (you’ll see some of my comments in there). 
 

 Option 2: download 5_GB_places.gpkg and 
8_UK_LAD_with_population.gpkg and then explore what 
I’ve done with the labelling for both of these layers – the 
local authority layer labelling is of course a lot more subtle. 
 

Once you’ve had a good look at these, play with them for a 
while. There is so much to labelling: it’s so flexible, and tricky! 
 
Did you know that you can type 
anything into the Value box in the 
Labels area of Layer Properties 
and that is what will be displayed 
on your map? It’s true.  
 
There is SO much we could say 
about labelling in QGIS, but that’s 
enough for now. 

Other labelling tricks you should know about – ask me if you need 
help: wordwrap, upper/lower/title, a simple find & replace method, 
conditional formatting for just about everything – case change, etc. 
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9. Take a ‘bad map’ better, and make it better 
Earlier on, I made a ‘bad map’ – as we all did. You can 
see my final map here:  
 
/training/data/images/BAD_MAP.jpeg 
 
I’d be interested to see some of yours, if you haven’t 
already shown me them (screen share, DM, email…). 
 

 Now open your BAD MAP project from about page 
25 and then, using everything we have talked 
about here, make it better! My BAD MAP example 
happens to match the ‘who came second?’ theme from 
section 7 and if yours does too that’s fine. The important 
thing is that your final map is as clean and clear as 
possible and you take your map from ‘BAD’ to ‘GOOD’. 

 
 If you get to this point after the end of the formal 

training schedule, don’t worry – you can still come 
back to me for help via email. If you’ve finished 
earlier than expected, that’s fine too – we can cover some 
bonus material or anything else you’d like to look at with 
QGIS. Either way, make sure you take a break and a drink. 
 

Here’s a short blog post where I go through some map layout 
design choices – you may find it useful and/or helpful here: 
www.statsmapsnpix.com/2018/07/map-layout-design-in-qgis-
atlas.html  

https://automaticknowledge.org/training/data/images/BAD_MAP.jpeg
http://www.statsmapsnpix.com/2018/07/map-layout-design-in-qgis-atlas.html
http://www.statsmapsnpix.com/2018/07/map-layout-design-in-qgis-atlas.html
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There are many ways to do things with QGIS, and not usually 
any one perfect or correct, best way of doing it.  
 
But, when it comes to designing maps and visuals that make an 
impact it is my view that the general Principles I invoked above 
can be very helpful, in addition to the following more specific 
map and QGIS-related principles. 
 

 Choose colours carefully. 
 Be careful with line widths. 
 Think about the end user – who are they? Quick scanners? 
 Good labelling is SO important, but takes time and thought. 
 Go easy on the ‘mapjunk’ (e.g. do you REALLY need that 

scale bar and north arrow?). 
 Have you got your map projection right? 
 DIY map legend, or use the built-in one? It depends. 
 What about class breaks in a choropleth? You need to be 

aware that there can be big differences: e.g. see this blog 
post: http://www.statsmapsnpix.com/2016/01/from-
anscombes-quartet-to-choropleth.html 

 Trying to show too many things? Be realistic about how 
much people can take in – if in doubt, simplify. 

 
I don’t like to leave people high and dry after a training session 
so if you’re stuck or need me to clarify anything, feel free to get 
in touch – email, website contact form, Twitter DM, whatever. 
 
Thanks for joining in!  

http://www.statsmapsnpix.com/2016/01/from-anscombes-quartet-to-choropleth.html
http://www.statsmapsnpix.com/2016/01/from-anscombes-quartet-to-choropleth.html
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10. Credits 
 
QGIS - QGIS is a user friendly Open Source Geographic Information System 
(GIS) licensed under the GNU General Public License. QGIS is an official 
project of the Open Source Geospatial Foundation (OSGeo). 
https://www.qgis.org/en/site/about/index.html  
 
Natural Earth – ‘no permission is needed to use Natural Earth data’. All 
versions of Natural Earth raster + vector map data found on this website 
are in the public domain. 
https://www.naturalearthdata.com/about/terms-of-use/ 
 
SimpleMaps – World Cities Database (Basic), used under the Creative 
Commons Attribution 4.0 licence. 
https://simplemaps.com/data/world-cities 
 
World Bank – Population data, used under the Creative Commons 
Attribution 4.0 licence. 
 
https://data.worldbank.org/indicator/SP.POP.TOTL 
 
Emojis are from Twemoji, at twemoji.twitter.com, licenced under the CC-BY 
4.0 licence. 
https://twemoji.twitter.com/ 
 
Poppins Font - Designed by Indian Type Foundry, Jonny Pinhorn, licenced 
under the Open Font Licence. 
https://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&id=OFL 
 
OpenFlights.org – airline data, used under the the Open Database License. 
https://openflights.org/data.html#license 
 

https://www.qgis.org/en/site/about/index.html
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
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11. Useful links 
Natural Earth – the best source for easy-to-use global map data, e.g. 
countries, places, states, roads, coastlines and much more. 
https://www.naturalearthdata.com 
 
simplemaps – world cities csv files, with lat/long coordinates. This is a 
great source for place name data. 
https://simplemaps.com/data/world-cities 
 
Sentinel-2 cloudless – for adding satellite imagery to QGIS. Right-click 
WMS/WMTS in the QGIS browser panel, then click New Connection… add 
Sentinel-2 cloudless to the Name and the second url below to the URL field. 
https://s2maps.eu/ 
https://tiles.maps.eox.at/wms?service=wms&request=getcapabilities 
 
OS OpenData Downloads (Ordnance Survey) – a huge amount of free, 
open geospatial data are now available from Ordnance Survey via their 
Open Data Hub. The data covers Great Britain and no registration is 
required. 
https://osdatahub.os.uk/downloads/open 
 
ONS Geography Portal (UK) – see the Boundaries section of this website 
for a wide range of UK boundary data. This site includes data for the whole 
of the UK, whereas Ordnance Survey data only covers Great Britain. A great 
resource. 
https://geoportal.statistics.gov.uk/ 
 
QGIS Documentation – the official help docs from the people who make 
QGIS. 
https://www.qgis.org/en/docs/index.html 
  

https://www.naturalearthdata.com/
https://s2maps.eu/
https://tiles.maps.eox.at/wms?service=wms&request=getcapabilities
https://osdatahub.os.uk/downloads/open
https://www.qgis.org/en/docs/index.html
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Back page cheat sheet 
These are things I use myself – to make things work faster, better, smoother.  
 CTRL+Tab turns panels on/off so the map area is full screen width. 
 Select some features, Edit > Copy Features then Edit > Paste Features As a new 

temporary layer (called a ‘scratch’ layer) or a new vector layer. 
 F11 for full screen mode, F1 for QGIS User Guide, F6 to open Attribute table (on Windows). 
 CTRL+Shift+Tab for full screen map mode (on Windows). Same again to undo. 
 Change projection for project (it doesn’t alter any data) via EPSG button, bottom right. 
 Black is too harsh, try #222222 / RGB 34, 34, 34 instead. Go beyond default colours! 
 Where is your layer stored? Double-click a layer, go to Information and see Path. 
 Turn on the thousand separator (1,000 vs 1000) – Settings > Options > General, tick box. 
 Want to save the position of your map? Use View > New Spatial Bookmark. 
 Print Layout looking fuzzy? Just hit refresh and that will fix it. 
 Print Layout page not zooming to full extent? Re-size your page, then reset to original. 
 Save your most commonly used data source paths as Favorites in the Browser. 
 When styling layers, you don’t have to use only the columns you already have – e.g. 

you can style based on calculations or even by extracting portions of text. 
 Hey, my lovely XYZ base map looks a bit fuzzy! Set projection to EPSG:3857. 
 Hey, my joined layer has weird column header names! Go back into Joins, and edit the 

join so that the Custom Field Name Prefix is ticked and the box is blank. 
 How do you do those glowing lines/polygons? That’s via Blending mode in Symbology. 
 Help! My side panel things have disappeared. Go to View > Panels. 
 Use Inverted polygons with a filter and a satellite base layer to create nice area maps 

– make layer white/black and use about 75% Opacity. 
 Go to Processing > History to view or re-run your recent geoprocessing tasks. 
 A general carto tip: try to make your map as simple as possible, remove any junk. 
 Type world into the Coordinate box if you want a world countries layer to use. 
 Use a 16:9 aspect ratio if your maps are mainly for screens (e.g. 320mm x 180mm). 
 Map a list of x and y coordinates quickly via Delimited Text in Data Source Manager. 
 Drag and drop files from your file browser directly into QGIS (e.g. shp, gpkg etc). 
 You can add layers via the WMS/WMTS option in Browser. Just Google it. 
 Want to save/re-use a map style for a layer? Layer Properties > Style > Save Style…  
 If you give the qml file the same name as a layer file and put it in the same folder as 

the file then when you add it to QGIS that style will be applied by default. 
 Learn about Draw effects! Use them to add a glow or a shadow to features. 
 View > Preview Mode to see your map in colour-blind safe modes or greyscale. 
 Best Plugins? MMQGIS, SRTM Downloader, Build Globe View, Qgis2threejs, qgis2web. 
 Add base maps via XYZ Tiles in Browser panel. OpenStreetMap is there by default. 


